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 Introduction

The Digimarc digital watermark is a technology for product packaging that enables encoding a Global Trade 
Identification Number (GTIN) or other product code imperceptibly into a package’s artwork prior to printing.

For a product, the GTIN carried by a digital watermark is the same as a traditional 1D UPC/EAN barcode. Because 
the digital watermark can be applied to all faces of a product’s packaging, a package enhanced with a Digimarc 
digital watermark supports higher efficiency at retail checkout, increased consumer engagement, more accurate 
inventory tracking, better supply chain management, and other benefits.

The Digimarc Verify application enables you to scan a print sample or import a press-ready digital image file of a 
package and verify that it meets the following conditions:

1 The GTIN information carried by the Digimarc digital watermark matches the GTIN information carried by 
the package’s traditional product code.

2 Only one GTIN is present in the package’s artwork.

3 Robustness of the digital watermark is sufficient for the intended use case.

Caution
It's critical that conditions (1) and (2) are met before plates are produced or a package goes to press for 
production printing.

If either condition isn't met, the package carries two (or more) distinct GTINs. If such a package is printed and 
placed on retail shelves, the wrong amount could be charged for a product, or two different products could be 
charged in one transaction. This could disrupt supply chains, inventory tracking, and so on.

This situation can arise if a plate or separation containing common artwork is used in two or more packages. If 
more than one package uses the same plate or separation containing a Digimarc digital watermark, it will result in 
conflicts with other digital watermarks and traditional product codes. If the plate or separation doesn't contain a 
digital watermark, it might be replacing a plate or separation that does, which would reduce the robustness
(strength) of the digital watermark in the printed package and compromise the effectiveness of the watermark.

Warning
Never reuse plates or separations from other jobs when printing packages enhanced with a Digimarc 
digital watermark.

Who Uses Digimarc Verify?
The primary Verify users are:

A printer verifying a print sample as a final check before printing a package at volume

You scan a packaging print sample on a validated  Epson Perfection v39 flatbed scanner and use Verify to 
inspect the scanned image for Digimarc digital watermarks and traditional product codes. (See Validate Your 
Scanner for more information.) Verify compares the GTIN information from any detected digital watermarks to 
each other and to the traditional product code.

• If conditions (1) and (2) are met, printing can proceed.
• If either condition isn't met, don't print the package until you determine the cause of the problem. Contact

Digimarc for help.
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A prepress operator verifying a press-ready digital image file as a final check before delivering the file for 
plate production

You import a press-ready digital image file of your package and use Verify to inspect the image for Digimarc 
digital watermarks and traditional product codes. Verify compares the GTIN information from any detected digital 
watermarks to each other and to the traditional product code.

• If conditions (1) and (2) are met, you can deliver the file for plate production.
• If either condition isn't met, don't deliver the file for plate production until you have identified and corrected

the problem. If you can't identify the problem, contact Digimarc for help.

Supported Media Formats
Digimarc Verify accepts the following digital image file formats. Files must be 300 DPI or greater. We recommend 
using them at full size (100%).

• PSD
• AI
• PDF
• BMP
• PNG
• TIF/TIFF

System Requirements
Digimarc Verify requires:

• macOS 13 (Ventura), 14 (Sonoma), or macOS 15 (Sequoia)
• Multicore Intel or ARM-based processor with 64-bit support
• 16 GB RAM recommended
• 100 MB of available hard-disk space for installation
•  Epson Perfection v39 flatbed scanner*
• An active internet connection **

Warning
Don't install Verify on a case-sensitive file system or on a removable flash storage device.

* Required only if you scan print samples for verification. See Who Uses Digimarc Verify?

** Required for full functionality.

Version 3.3.1 250421
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Document Conventions
Following are the standards and conventions used in this documentation. See the Glossary for terms related to 
digital watermarking.

Convention Description

Numeric format* The fractional part of a numeric value is represented by the period character, 
such as pi =~ 3.14

Measurements* Measurements are shown in inches, abbreviated to "in," such as 
Dimensions: 5.66 x 4.68 in

Clickable elements in the 
user interface

Formatting: Text in bold

Titles of sections, panels, 
and dialogs

Formatting: Text in italics

Text that a user types Formatting: Text in a monospace font

File and directory paths Formatting: Text in a monospace font

Variables or variable data Formatting: Text in italics, often within angle brackets (< >)

* The Digimarc Verify application adapts to your operating system's regional conventions.
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 Install Digimarc Verify

You can get the Verify application from Digimarc's website at  https://my.digimarc.com.

1 Log into  My.Digimarc. If you don't have credentials, contact your Digimarc account representative.

2 In the Downloads module, click Access Site.

3 Click Download for the desired operating system. The Digimarc Verify dmg file is saved to your default 
downloads folder.

4 Run the installer.

Warning
Don't install Verify on a case-sensitive file system or on a removable flash storage device.

Note
If you have problems installing Verify, you might need to give the installer Full Disk Access:

4.1 Open the Privacy and Security settings dialog.

4.2 Select Full Disk Access.

4.3 Click the plus ( + ) icon and enable Installer. The Installer application is located in 
System/Library/CoreServices.

Tips
Some Digimarc software products always display scroll bars. Verify displays scroll bars according to 
your system preferences setting. To change your settings to always show scroll bars in Verify and other 
apps, go to System Settings > General and set Show scroll bars to Always.

Verify supports Dark Mode. You can select Dark Mode using the Appearance option at the top of the 
same screen.

For next steps, see Getting Started with Digimarc Verify.

Version 3.3.1 250421
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Validate Your Scanner
This section is for those who plan to scan print samples for verification. If you're importing digital artwork files, skip 
this procedure.

We support only the  Epson Perfection v39 flatbed scanner. See System Requirements.

Before verifying any print samples of packages, validate your scanner to ensure accurate results. You can find the 
Scanner Validation file by opening Verify and going to Help > Scanner Validation.

1 Print the file on a calibrated proofing system at 100%.

2 Add the artwork to your project. 
• On a valid scanner, Digimarc Verify detects one traditional product code and one mismatched

Digimarc digital watermark. The message "A possible GTIN conflict was found" is displayed during
the pre-verify step.

• Any other result indicates an invalid scanner.

3 Follow steps 4-6 in Verify the Artwork. The result of the verification is Fail: Inconsistent barcodes were 
found on the package.

Version 3.3.1 250421
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 Getting Started with Digimarc Verify

When you open Verify, a blank artboard is shown.

1 Menu bar: The menu bar is where you manage projects and artwork, set the color profile, and more. The 
Edit and Window menus are standard on the macOS and have no Verify-specific options.

• Digimarc Verify
- About Digimarc Verify: Opens the About dialog, displaying the version number and

copyright information.
- Hide Digimarc Verify: Hides the application.
- Quit Digimarc Verify: Closes Verify.

• File
- Manage Region Templates: Opens a dialog where you can manage region templates.

• Preferences
- Default CMYK ICC Profile: Opens the Default CMYK ICC Profile dialog where you can set a

default ICC profile.
- Advanced Detection: This option is intended for use by Digimarc or under Digimarc's

direction. Enabling it could slow the verification process.
- Illuminate Preview Environment: Verify looks for matching digital twins in the Illuminate™

production environment by default. To instruct Verify to look for matching digital twins in the
preview environment, enable this option. See Change Environments for more information.

Version 3.3.1 250421
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• Projects
- Create Project: Projects contain artwork to be verified. If you don't create a project before

adding the art file or scanning the print sample, Verify automatically creates a project for
you.

- Manage Projects: Opens the Manage Projects dialog where you can open a project or
delete one or more projects.

- Add Artwork from File: Enables you to import a press-ready digital image file.
- Add Artwork from Scan: Enables you to scan print samples. See Validate Your Scanner for

more information.
• View

- Hide Project panel: Hides the Project panel on the left.
- Hide Results panel: Hides the Results panel on the right.

• Help
- Documentation: Opens this documentation.
- Legal Notices: Displays the Verify end user license agreement and third-party software

license information.
- Supplemental Features: Enables you to enter an activation code to enable extra features.

See Enable Supplemental Features.
- Scanner Validation: Opens the scanner validation file. See Validate Your Scanner for

details.
- Contact Us: Displays the Contact Us dialog, providing support contact and application

version information.

2 Project Tab: Displays tools and information related to the project.
• Toolbar: These icons enable you to add or remove artwork from a project or run a report.

- Add artwork from file  : Enables you to import a press-ready digital art file.

- Add artwork from scan  : Enables you to scan a print-ready sample. See Validate Your 
Scanner for more information.

- Remove selected artwork from project  : Removes the artwork from the project without
deleting any associated files.

- PDF report  : After you Run Verify, enables you to generate enhancement reports.
• Run Verify: Starts the verification process. Results are shown in the Results panel.
• Project Metadata:

- Project Name - The name of the project.
- Account Name - The name of the account the project belongs to. We recommend you use

the account name that was used to create the Digimarc digital watermark in the Illuminate
Platform or Packaging module on My.Digimarc.

- Project ID - The alphanumeric identifier for the project.
• Use Case Analysis: This option group enables you to select the scanning environments the

package might be used in. See Select the Use Case Analysis for instructions.
- Point of Sale: For red-light check-out (barcode) scanners in storefronts. See Point of Sale for

details.
- Mobile Phone: For users who scan the product package with Digimarc Discover or other

mobile apps that incorporate the Digimarc Mobile SDK. See Mobile Consumer
Engagement for details.

- Manufacturing: For scanners used in manufacturing and supply chain environments.
See Manufacturing for details.

- Robot: For inventory tracking robots or other kinds of robotic scanners. See Robot
Monitoring for details.
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- Recycling: For scanners connected to recycling sortation machines. See Recycling
Sortation for details.

Note
Recycling Sortation is a Supplemental Feature and must be enabled before it 
becomes visible and selectable.

• Artwork Summary: Displays a thumbnail image of each artwork in the project with its file name.
• Color Channels: Displays all the color channels detected in the artwork.
• Icons: Below the Color Channels are three icons:

- Green Digimarc icon: Indicates the color channels that were watermarked.
- Grayscale wheel: Opens the grayscale color separations folder.
- Color wheel: Opens the Spot Color Identification dialog.

3 Artboard Toolbar: These icons enable you to set geometry parameters for the main artboard.
• Magnet/snap-to behavior: Toggles the snap-to behavior for regions. See Select Regions.
• Geometry: Enables you to specify whether the currently selected region is flat or cylindrical.

See Select the Geometry.
- Flat: The region is intended for a flat package section.
- Cylindrical: The region is intended for a cylinder, such as a can.

• Orientation: Selects whether the label will be wrapped around the cylinder horizontally ( ) or
vertically ( ). This applies only to cylindrical regions and is disabled for flat regions. See Select
the Orientation.

• Label wrap percentage: Selects the percentage of the package the artwork covers. This applies
only to cylindrical regions and is disabled for flat regions. See Select the Label Wrap Percentage.

4 Artboard Tabs: The Regions and Maps tabs show you the regions that you've identified and the validation 
maps that Verify generates.

• The Regions tab contains the artboard (canvas) that displays the artwork and any regions you've
defined.

• The Maps tab shows the validation map for the analyzed package. This tab is empty until you Run
Verify. A table at the bottom of the tab shows the different coverage or consistency maps. The color
coding corresponds to the coverage score.

5 Details Tabs: The Region Details and Results tabs show the details for each region you've identified and 
the results of the verification operation.

• Region Details: Displays the properties selected for each region, including its size, location, and
geometric parameters.

• Results: Displays the validation results from the analysis and more detailed region information, such
as the coverage area and coverage score for the selected Use Case Analysis. These results show
how well the embedded Digimarc digital watermark will operate for each Use Case Analysis. No
results are displayed until you Run Verify.

Enable Supplemental Features
Supplemental features require an activation code to enable the associated functionality. 

Verify supports the following supplemental features:

• Recycling sortation use case
• Watermark in varnish channels

To learn more about them, contact Digimarc.
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To activate a supplemental feature:

1 From the menu, select Help > Supplemental Features.

2 Type or paste the activation code you got from Digimarc.

3 Click Enable. 

If the code is recognized, the feature is enabled and becomes visible in Verify.

Change Environments
When verifying watermarks that originate from Illuminate, Digimarc Verify looks for the digital twin information 
from the production environment by default. If the watermark was applied to the artwork from a digital twin that 
was created in the preview environment, you must instruct Verify to look for the matching digital twin in the 
preview environment. Digital twins that exist in preview won't be found on the production environment or the 
other way around.

Note
The option to change environments applies only to digital watermarks created in Illuminate and applied 
to artwork using the Digimarc Watermarking Plug-in. If you're using artwork that was watermarked using 
the Digimarc for Packaging Extension for Adobe Illustrator, changing environments has no effect.

IMPORTANT
Applications that read Digimarc digital watermarks, such as devices that support the various use cases, 
can read watermarks created only in the production environment. If you go to production with a 
watermark created in the preview environment, those devices won't be able to read it.

To change to the preview environment:

1 From the menu, select Preferences > Illuminate Preview Environment. A dialog opens, asking you to 
confirm you want to change environments.

2 Click Yes. The Preferences > Illuminate Preview Environment menu option displays a check mark, 
indicating you're using the preview environment.

To change to the production environment:

1 From the menu, select Preferences > Illuminate Preview Environment. A dialog opens, asking you to 
confirm you want to change to the production environment.

2 Click Yes. The Preferences > Illuminate Preview Environment menu option no longer displays a check 
mark.
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Guide to Digimarc Verify 13 

 Verify the Artwork

The verification process ensures the enhanced artwork contains the correct digital watermark for the package 
being printed. For information about the application user interface, see Getting Started with Digimarc Verify.

1 Click + NEW PROJECT to create a project. To work with an existing project, see Manage Projects for 
instructions on opening a project. 

Note
Artwork must be in a project. If you skip this step, Digimarc Verify creates a project for you.

2 Name the project and provide an Account Name or Project ID or both. This step is optional but 
recommended.

3 Add the enhanced artwork. See Add Artwork to a Project for instructions.

4 Select regions of the package. See Select Regions for instructions.

5 Enable the desired use case analyses for the verification. See Select the Use Case Analysis for 
instructions.

Tip
To get coverage area, coverage score, and coverage maps, enable Point of Sale, Mobile 
Phone, or Recycling.

6 After all images and regions for a package have been added as desired, click RUN VERIFY . When 
verification is done, the Results tab shows whether validation has succeeded or failed. See Understanding 
Results and Report Details for more information.

Add Artwork to a Project
Each project can have one or more pieces of artwork. Some projects have different artwork for the body of the 
product package and the lid. 

You have two options for adding artwork to a project:

• scan a print-ready sample
• import a press-ready digital art file

Best Practice
As a general rule, we recommend you supply press-ready files to Digimarc Verify. Verify checks 
for a watermark in all separations and how they interact with one another. Not including colors 
or not setting proper transparencies could impact the results. Accurate color correction, 
trapping, overprints, and so on produce the most accurate coverage maps and Verify data 
(watermarked channels, application ratings, fidelity points, and so on).

To scan a print-ready sample:

Digimarc Verify supports the  Epson Perfection v39 flatbed scanner. Use these steps to verify the scanner 
validation file or scanned artwork.

1 Prepare the print sample. See Preparing the Print Sample for instructions.

Version 3.3.1 250421
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2 Connect the scanner and ensure it's turned on. 

3 Click Add Artwork from Scan (   ). 

4 Select the scanner to use. 

5 Click Scan.

6 To add more images for the same package, repeat these steps.

To import a press-ready digital art file:

1 Click Add Artwork from File (   ).

2 Navigate to the file to use. Files be 300 DPI or higher, and we recommend using them at full size (100%). 
See Supported Media Formats for more information.

Note
You can import an RGB image file that was created from a previously scanned print sample. In 
this case, the image is treated the same as a scanned sample.

3 Click Open. Verify detects embedded ICC profiles for CMYK art files. If you import a file without an 
embedded ICC profile, the software prompts you to import an ICC profile or use the default profile for 
analysis. 
The Verify application analyzes selected spot colors to simulate how devices such as red-light scanners 
and mobile phones detect Digimarc digital watermark coverage. For more information about this analysis, 
see Spot Color and Technical Inks.

4 To add more images for the same package, repeat these steps.

Preparing the Print Sample
If you're scanning print samples to verify, each package must be scanned completely, one at a time. Before 
launching Digimarc Verify and scanning, we recommend you prepare the print sample.

• If two (or more) packages share a single print sample (below left), cut the sheet so that each package is on
a separate sheet (below right).
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• If a print sample with a single package is too large to fit on the scanner bed (below left), cut the sheet into
smaller pieces that fit completely on the scanner bed (below right). You scan the smaller sheets separately
and combine them using an image editor, which enables you to verify the individually scanned sheets as a
single package.

Note
Be sure to leave the 1D barcode intact when cutting print samples.

Set the ICC Profile
Digimarc Verify ships with GRACoL2006_Coated1v2 as the default ICC profile for imported CMYK art files. If you 
import artwork that has no ICC profile embedded, such as an Adobe Illustrator (.ai) or PDF file, Verify offers to use 
the default profile or a profile you import.

Note
The color profile used in scanned RGB images varies, depending on the OS version. It can't be changed 
in Verify but doesn't affect the analysis.
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• To use the default ICC profile, click Continue.
• To use a different profile, click Import, navigate to the ICC profile file you want to use, and click Open.
• To cancel the import operation, click Cancel.

The ICC profile file name that was used for each imported image is shown in the artwork toolbar. 

Note
Artwork that has already been imported is unaffected by a change in the default ICC profile. To apply a 
different ICC profile to the artwork, remove the file from the project and import it again with the desired 
profile.

To set a different ICC profile as the default:

1 Select Preferences > Default CMYK ICC Profile from the menu. The Default CMYK ICC Profile dialog 
opens.

2 Click Select New ICC Profile.

3 Navigate to the desired ICC profile file on your computer and click Open.

To reset GRACoL2006_Coated1v2 as the default ICC profile:

1 Select Preferences > Default CMYK ICC Profile from the menu. The Default CMYK ICC Profile dialog 
opens.

2 Click Reset.
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Spot Colors and Technical Inks
When you import press-ready digital image files, Digimarc Verify analyzes spot colors to simulate how different 
devices detect the Digimarc digital watermark. Verify can analyze up to ten spot color channels per file (which 
includes up to two white ink channels and up to two varnish channels) in addition to the four process channels.

Select the Substrate

The packaging material (substrate) affects how the watermarks perform.

To set the substrate:

1 If needed, open the Spot Color Identification dialog by clicking the spot color icon. For artwork with spot 
colors, this dialog opens automatically after you add the artwork to a project.

2 If the file contains a watermarked varnish channel, enable the Is there a watermarked varnish in this file?
option. 

Note
Varnish watermarking is a supplemental feature. This option doesn't appear in the Spot Color 
Identification dialog unless the feature has been enabled. See Enable Supplemental Features.

2.1 Enable the Varnish option under Special Inks for one or two watermarked varnish channels. If the 
artwork has varnish channels that aren't watermarked, don't enable the Varnish option for those 
channels.
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3 Select the Substrate from the drop-down. The default is Opaque. Digimarc Verify supports the 
following substrates:
Opaque

This option is for artwork printed on an opaque substrate, such as white card stock. The package 
inks are the primary contributor to the final package color.

Clear (dark contents)
This option is for artwork with a watermark printed on a clear or transparent substrate filled or 
backed by a color with low reflectance, such as black.

Clear (light contents)
This option is for artwork with a watermark printed on a clear or transparent substrate filled or 
backed by a color with high reflectance, such as white.

Foil
This option is for artwork with a watermark printed on foil or similar metallized substrates.

Select the Spot Colors to Analyze

Verify matches the ink separations to known colors. If it doesn't recognize an ink separation name, the application 
tries to substitute a known ink for the unknown one. See Color Matching in Verify for more information about how 
the application determines color matching.

Tip
You don't need to include the dieline in the analysis; dielines aren't usually watermarked. Including 
them in the preview can help you place regions accurately.

To set the color channels to include:

1 Select the channels to include in the preview. We recommend including all color channels in the preview.

2 Select the spot colors to analyze. If the substrate is foil or clear, identify the white ink channels. You can 
have a maximum of two white ink channels for each artwork file.

3 If the artwork you're working with has a watermark in varnish channels, enable the Varnish option for the 
relevant channels. You can have a maximum of two varnish channels for each artwork file.

Note
Application ratings aren't available for projects with watermarked varnish.

4 To continue, click OK. To skip this file, click Cancel.

Select Regions
You use regions to designate the sides of a package and instruct Verify where to expect a digital 
watermark. Artwork that falls outside a designated region isn't evaluated. We recommend covering all areas of the 
artwork with regions to get the most accurate and complete evaluation of the digital watermark's expected 
performance for your use case(s).

When you move the cursor to an area of the artboard where no regions exist, it becomes the marquee cursor (  ), 

showing you can draw regions over the artwork. The cursor becomes a move cursor (   ) when positioned over a 
region. It becomes a resize cursor (  or   ) when positioned over a region's edges.
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Snap-to Guidelines
When you draw, resize, or move a region on artwork that already has one or more regions, blue guidelines show 
when the edges of the regions align. Red lines show where regions overlap. You can't Run Verify on a project with 
overlapping regions.

To help you accurately place and size the regions, Verify "snaps" the region borders to the vertical or horizontal 
guidelines. To disable or enable the snap-to behavior, click the Magnet icon (  ) in the artboard toolbar. It's 
enabled by default.

Tips
Regions snap to the guidelines when you release the mouse button after sizing or moving a region.

To temporarily disable the snap-to behavior, press and hold <Command> while sizing or moving a 
region.

Add a Region
To add a region:

1 Drag the marquee cursor (  ) over the artwork to select different regions of the package to mark areas to 
verify. The minimum detectable size for a region is about 0.33 in2 (0.84 cm2) at 75 WPI and 0.18 in2 (0.46 
cm2) at 150 WPI. You can have up to ten regions across all images in the project.

• To delete a region, select it and press Delete.
• To move a region, drag and drop it as desired.
• To resize a region, drag and drop the edges.
• To change a region's name, you can:

- Right-click it and choose Rename Region to > <region name> (front, back, left, right, top, or
bottom).

- Right-click it and choose Edit Region Name. In the Rename Region dialog, type the desired
name and click OK.

Region names can contain only alphanumeric characters, spaces, parentheses, underscores, and 
hyphens.

2 Identify a region to represent the principal display panel. This is usually the region designated as the front 
of the package. Right-click the desired region and choose Make Region the Principal Display Panel. That 
region is marked with a star (  ).

Warning
If Mobile Phone or Robot is enabled in the Use Case Analysis section, one region must be 
marked as the principal display panel. If you don't choose one, one is chosen and marked for 
you when you run the verification.

3 To deselect regions, click an empty spot on the artboard.

4 To designate a region as flat or cylindrical, select the region and choose the desired Geometry (   ). The 
default is flat. See Artboard Toolbar Options and Working with Cylinders for more information.

5 Repeat these steps to add a region for each enhanced area of the artwork.
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Copy a Region
After you draw a region, you can copy it to another area of the artwork. The marquee cursor becomes a move 
cursor when positioned over a region.

To copy a region:

1 Right-click a region to select it and open the context menu.

2 Choose Copy Region. Verify pastes a copy of the region to the artboard. It has a default name, such as 
Region 1.

Note
If you copy a region that's too large to fit on the artboard without overlapping an existing region, 
the copy fails.

3 Drag the new region to the desired location. You can also size it as needed.

Artboard Toolbar Options
Artwork that's enhanced with digital watermarks usually goes on the external product packaging. The packaging 
material, shape, and how it's oriented on store or warehouse shelves affect how the watermark is read.

Select the Geometry

Product packages come in a variety of shapes and sizes. Some are flat, like a box, while others are cylindrical, like 
a can. Digimarc Verify supports two geometries:

• Flat: boxes and labels whose packaging is flat
• Cylinder: cans, tubs, bottles, or labels that wrap around a cylinder

For a cylindrical package, robot monitoring and mobile analyses require the camera-facing portion of the package 
to be identified as the principal display panel. To facilitate this, a white panel, the label wrap panel, is displayed 
over the artwork to show the approximate area of the package that will be visible from store or warehouse 
shelves. The size of the label wrap panel changes depending on the label wrap percentage. Drag the label wrap 
panel to cover the primary, camera-facing portion of the package. 

Note
The label wrap panel is shown only on the principal display panel. This option is disabled for flat 
regions.

Version 3.3.1 250421



Guide to Digimarc Verify 21 

Example artwork for a flat package

Example artwork for a cylindrical package

Note
Some packages have artwork that includes both cylinders and flats. An example is a yogurt tub with 
one design that wraps around the tub and another that goes on the lid.
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To set the geometry:

1 Select the region to work with.

2 From the toolbar, click the Geometry icon (   ).

3 Choose the correct geometry. The default is Flat.

For information about working with cylindrical packages, see Working with Cylinders.

Select the Orientation

When working with artwork that wraps around a cylinder, how the artwork is oriented for reading could impact 
how the watermarks are detected.

Note
This property applies only for regions whose Geometry is Cylinder. The icon is disabled for Flat regions.

Verify supports two orientations:

• Wrap horizontal: the artwork wraps horizontally around the cylinder, like a soup can (   )
• Wrap vertical: the artwork wraps vertically around the cylinder, like a juice can (   )

To set the orientation:

1 Select the region to work with.

2 From the toolbar, click the Orientation icon (   ). 

3 Choose the correct orientation. The default is Wrap horizontal. 

For information about working with cylindrical packages, see Working with Cylinders.

Select the Label Wrap Percentage

When working with artwork that wraps around a cylinder, you can specify what portion of the package is covered 
by the region. This feature shows where watermark detection would be strongest when the product is scanned on 
a store shelf.

Note
This property applies only for regions whose Geometry is Cylinder. The icon is disabled for Flat regions.

Verify supports four label wrap values:

• 100% (default): the region completely covers the cylinder
• 75%: the region covers three-quarters of the cylinder
• 50%: the region covers half the cylinder
• 25%: the region covers one quarter of the cylinder
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To set the label wrap percentage:

1 Select the Principal Display Panel region, which is marked with a star (  ). The label wrap panel is placed 
on the principal display panel region.

Label wrap panel ( A ) on the principal display panel

2 From the toolbar, click the Label wrap percentage icon (   ).

3 Choose the value that represents the portion of the package that's covered by the region. In the example 
above, we used 100% (default).

4 Drag the label wrap panel to the area of the artwork that would best represent the camera-facing portion 
of the package.

Working with Cylinders
Most packaging has flat sides, such as a box of cereal or toothpaste. Some packages are cylindrical, such as a can 
of soup or frozen juice concentrate. The options on the artboard toolbar will help you select the right properties to 
get the best results from the digital watermark on your cylindrical packages.

Cylindrical packages present a challenge because when the product is sitting on store or warehouse shelves, the 
edges of the watermark could be farther away from the scanner or camera than the center is, causing some 
distortion. Digimarc Verify includes features to help determine the predicted success various scanners will have in 
reading the digital watermark on cylindrical packages.

You use the artboard toolbar to select options related to package shape.

• The Geometry icon (  ) enables you to choose between Flat and Cylinder.

• The Orientation icon (  ) enables you to choose whether the label is wrapped around the package 
vertically like a frozen juice container, or horizontally like a soup can.

• The Label Wrap Percentage icon (  ) enables you to specify how much of the package artwork is 
visible from the front.
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Orientation

How the label is oriented on the package helps determine the size and shape of the label wrap panel. Consider 
these examples:

Geometry: Cylinder

Orientation: Wrap horizontal

Geometry: Cylinder

Orientation: Wrap vertical

Label Wrap Percentage

For a cylindrical package, robot monitoring and mobile analyses require the camera-facing portion of the package 
to be identified as the principal display panel. To facilitate this, a white panel, the label wrap panel, is displayed 
over the artwork to show the approximate area of the package that will be visible from store or warehouse 
shelves. The size of the label wrap panel changes depending on the label wrap percentage. Drag the label wrap 
panel to cover the primary, camera-facing portion of the package. 

Note
The label wrap panel is shown only on the principal display panel. This option is disabled for flat 
regions.

Digimarc Verify calculates the circumference of the cylinder based on the dimensions of the package artwork, the 
regions that cover it, and the Label Wrap Percentage you select. The size of the label wrap panel depends on 
these calculations.

The following examples show a label designed for a bottle of champagne. The Orientation is Wrap horizontal, but 
the same principles apply for regions whose orientation is Wrap vertical.
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Example 1

The first example shows a single region, Front, that completely covers the label artwork. The label wrap 
percentage is set to 100% because the artwork wraps completely around the bottle, whose circumference is 
about eight inches. Verify calculates the label wrap panel dimensions based on these measurements.

Example 2

The second example shows the Front region on the label for a larger bottle with a 16-inch circumference. The 
label has the same dimensions as in the first example, but it only wraps half-way around the bottle. The label wrap 
percentage is set to 50%. The label wrap panel is wider than in the first example because the bottle itself is wider, 
so the portion of the label that can be scanned from a store or warehouse shelf is wider.

Version 3.3.1 250421



Guide to Digimarc Verify 26 

Multiple Cylindrical Regions
If you place multiple cylindrical regions on the artwork, each region has its own label wrap percentage value, 
but Verify places the label wrap panel only on the principal display panel region.

Example 3

The third example shows a label that wraps completely around the bottle. The artwork has two regions, Front and 
Back. Because the Front region of the label covers about three-quarters of the bottle's circumference, the label 
wrap percentage is set to 75%. The label wrap percentage for the Back region is set to 25%.

Selecting the Use Case Analysis
To get the most complete verification data, enable one or more use case analyses before you Run Verify. The 
analysis you select depends on the environment. This table summarizes the hardware and user behavior 
expectations for each type of analysis.

Note
Recycling Sortation is a Supplemental Feature and must be enabled before it becomes visible and 
selectable.
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Use Cases

Application Hardware Behavior

Retail Point-of-Sale with 
Fixed Barcode Scanners

• Illumination is red light (670
nm)

• Image sensor is monochrome
• Optical quality is low
• Scanner views one or two

sides only

• Package is swiped straight across the
scanner

• Users are trained or constrained to
swipe along package edges

Mobile Scanning with 
Consumer Apps

• Illumination is white light
(D50)

• Image sensor is RGB
• Optical quality is moderate
• Device field-of-view is a 4-

inch by 4-inch square

• User can target any location on
package

• As a rule, emphasis is placed on the
principal display panel or on the CTA
(call to action) if present

Manufacturing with 
Industrial Barcode 
Imaging

• Illumination is red light (620
nm)

• Image sensor is monochrome
• Optical quality is very high

(that is, distortion, noise, and
blur are negligible)

• Field of view is configurable

• Image capture is targeted to a
selected location or locations on the
package

• View is straight-on to the package

Shelf Analysis with Robot 
Monitoring

• Illumination is white light
(D50) with sufficient intensity
for detection

• Image sensor is RGB;
processing might be red-
channel only

• Optical quality is high with
sufficient resolution for
detection at working distance

• Robot captures an image of the
entire principal display panel of
the package

• View is straight-on to the package's
principal display panel

Recycling Sortation

• Illumination is red light
(670nm), Near-Infrared Light
(NIR) (730nm), and blue
(450nm) wavelengths

• Image sensor is monochrome
• Optical quality is high with

sufficient resolution for
detection at working distance

• Field of view is wide

• The entire package is scanned at
speed on a conveyer belt

• Package is often crumpled or dirty or
both
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 Understanding Results and Report Details

Digimarc Verify provides meaningful validation results through the user interface and enhancement reports in 
PDF.

Reports are saved in the folder \Home\Digimarc Verify\Reports.

• Validation results provide information about the coverage area, score, and application ratings for
applicable analyses. For more information, see Viewing the Validation Results.

• Enhancement reports give you detailed information about the detection of a Digimarc digital watermark in
the artwork. To get an enhancement report, see Create the Enhancement Report. Each report contains one
or more sections. For more information, see Enhancement Report Sections.

Depending on the selected sections, the enhancement reports can include any or all of:

• Details about the project
• Validation results; the identified GTIN and Digimarc digital watermark coverage information
• A list of the ink separations found with Digimarc digital watermark
• A fidelity point check map
• A validation points map
• A polarity map
• A varnish map
• A channel color reference list that gives details about the color channels in the artwork, with target value

metrics to be used during press QC activities to confirm the document has been reproduced with
acceptable ink densities and colors

Note
Ink separations with enhanced areas smaller than a Digimarc digital watermark tile might not be 
detected and reported in the Separations with Digimarc digital watermark section. Image previews 
shown in the Enhancement Report might not show spot colors as they would be displayed in graphics 
editors.

Viewing the Validation Results
When verification finishes, the Results panel shows whether the traditional product code and Digimarc digital 
watermark match.

For artwork with a successful validation result, the Results panel gives information for the entire package and by 
region. Package and region information is limited for failed validation results. In some cases, such as Digimarc for 
Print, you can get a successful result without a traditional 1D barcode validation.

Note
Validation results aren't saved in projects when you exit Verify, but they're kept in memory if you switch 
between projects. When you reopen a project, the Results and Maps panels are initially empty 
regardless of past verification activity. Run Verify again to get updated results.
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Validation Results
The Validation Results section displays information about the digital watermark embedded in the artwork. These 
results determine what's displayed in the Messages section and depend on the source of the watermark used to 
enhance the package.

Caution
If data validation fails for any reason, don't prepare plates or send the package for printing. Immediately 
contact your enhancement provider to correct the error. If such a package is printed and placed on 
retail shelves, the wrong amount could be charged, or two different products could be charged in one 
transaction. This could disrupt supply chains, inventory tracking, and so on.

• Barcode icon, if present, shows the value of the 1D traditional barcode on the package.

• Digimarc icon shows the digital watermark value that's been embedded in the artwork. The validation
results depend on how the package was enhanced:

- Non-Illuminate watermarks: If the watermark has a 1D traditional barcode, it might be required to
match the Barcode value for successful validation, depending on the watermarking tool used and
how it was configured. For example, if the artwork was watermarked using the Digimarc Print &
Audio module, Verify displays a success message though the values don't match.

- Illuminate watermarks: The traditional product code might be required to match the digital
watermark, depending on the type of account and digital twin:
Product digital twins

• If the account is a GS1 member, the Digimarc value must match the Barcode value for
successful validation. If the Digimarc value doesn't match the Barcode value, Verify displays
a failure message.

• If the account isn't a GS1 member, any 1D traditional barcode on the package isn't required
to match the Digimarc value.

Other digital twins

• For product variant or promotional assets, any 1D traditional barcode on the package isn't
required to match the Digimarc value.

• WPI (waxels per inch) is an advanced artwork setting that's changed only in certain circumstances during
enhancement. Digimarc Verify supports WPI settings of 75 and 150; if the artwork is enhanced at any other
setting, Verify displays a warning.

Version 3.3.1 250421



Guide to Digimarc Verify 30 

Messages
In the Messages section of the Results panel, Verify displays successful results in green text with a check mark 
icon, warnings in orange text with an alert icon, and failures in red text with an error icon. See Failure Types for 
more information about the failures you could see.

Result type Icon Sample messages

Success
Confirmed match of Digimarc digital watermark and traditional product code.

not configured to match a traditional product code found.

Warning

A was found with no other product code.

A traditional product code was found in addition to the . Confirm no match is 
needed before continuing.

Failure
Inconsistent barcodes were found on the package.

No or traditional product codes found.
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Package Information and Region Information
You can use the Package Information and Region Information as quality control measures for the application of 
a Digimarc digital watermark. Measurements are given for barcode scanners, mobile devices, and robot 
monitoring. This information is also included in the Enhancement Report.

• Rating shows the predicted performance of a Digimarc-enhanced package for the specified use case. This
assessment is based on the enhancement strength and coverage in key areas and is displayed on a scale
of 0–5, where 5 is best. See Application Ratings for more information.

• Coverage Area shows how much of the package is covered by a Digimarc digital watermark in square
inches (in2) or centimeters (cm2).

• Coverage Score shows the overall quality of Digimarc digital watermark coverage, where 100 is best. The
coverage score is the average of all detected coverage in the selected region.
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Maps
Maps show the areas on the package where Verify found a digital watermark. The color legend describes the 
strength of the watermark in each area. Click the rows in the table at the bottom of the window to view the 
different maps.

Failure Types
When one of the following warnings or alerts is displayed in the Results panel, work with the enhancement 
provider to resolve the problem. For more help troubleshooting problems, see Troubleshooting.

Multiple Digimarc Watermarks

The Validation Results show there are multiple Digimarc Digimarc digital watermark. Areas that contain 
mismatched digital watermark information appear red in the Validation Map.

Warning
Don't print the package. Contact your enhancement provider to correct the error. 

Digimarc Watermark Mismatches Traditional Product Code

The Validation Results show the Digimarc digital watermark doesn't match the traditional product code.

Warning
Don't print the package. Contact your enhancement provider to correct the error. 

No Traditional Product Code Found

The Validation Results show that no traditional product code was found on the package. Don't print the package 
until you have confirmed that it was designed without a traditional product code.

No Digimarc Watermark Found

The Validation Results show that no Digimarc digital watermark was found on the package. Don't print the 
package until you have confirmed that it was designed without a digital watermark.

No Traditional Product Code or Digimarc Watermark Found

The Validation Results show that neither a Digimarc digital watermark nor a traditional product code was found on 
the package. Don't print the package until you have confirmed that it was designed without a digital watermark or 
traditional product code.

Multiple Traditional Product Codes and Digimarc Watermarks Found

The Validation Results show that multiple digital watermarks and traditional product codes were found.

Warning
Don't print the package. Contact your enhancement provider to correct the error. 
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Create the Enhancement Report
After you Run Verify on the artwork project, Digimarc Verify offers four reports, each of which contains all or a 
subset of the report sections described below. For more information, see Understanding Results and Report 
Details.

To create the enhancement report:

1 From the Project Toolbar, click the PDF Report icon (   ). The Report Options dialog opens.
Reports: Select a report from the drop-down list:

• Full Report: Includes all the sections listed
below.

• Summary Only: Includes only the condensed
summary section.

• Brief: Includes the condensed summary,
watermark coverage, polarity map, varnish
map, and general information sections.

• Inspection: Includes the condensed summary,
validation point, fidelity point, polarity map,
varnish map, target-value information (TVI), and
general information sections.

Sections: Shows the sections available in the report:

• Condensed summary
• Watermark coverage
• Validation point
• Coverage map
• Polarity map
• Varnish map
• Fidelity point
• Target-Value Information (TVI)
• General information

2 Select the desired report and enable the sections to include. To exclude a section from the report, disable 
it.

3 Click OK. Verify generates the report, and the Save Report dialog opens.

4 Specify the file name and location to save the PDF report file. Click Save. The PDF report opens with your 
default PDF viewer.

Application Ratings
Application ratings show the predicted performance of a Digimarc-watermarked package or label for the specified 
use case. This assessment is based on the enhancement strength and coverage in key areas. The rating is on a 
five-star scale, where five stars is best. The table below summarizes the general performance expectations:

Star rating Detection Details

★ Unlikely Less than minimal detection

★★ Minimal Not recommended for intended applications

★★★ Acceptable Recommended minimum for all intended applications

★★★★ Reliable Exceeds minimum recommended coverage

★★★★★ Optimized Preferred rating for all applications
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Note
Application ratings aren't available for projects with watermarked varnish.

How Application Ratings Are Calculated
Application ratings show the predicted performance of a Digimarc-watermarked package or label for a specified 
use-case application (Retail Fixed Barcode Scanning, Mobile Consumer Engagement, Robot Monitoring, or 
Manufacturing). This assessment is based on the detected enhancement strength and coverage in key areas and 
is rated on a five-star scale, where five stars is best.

When calculating application ratings, several factors are considered:

• Application: Each application includes expectations for performance, hardware, and user behavior
• Placement: Where enhancement is detected on the package, determined by user-defined regions in

Digimarc Verify (for example, identifying the front, back, top, bottom, left, and right sides of a square
package or the front of a cylindrical package)

• Strength: The strength of the enhancement, determined by fidelity scores, shown as an array of colors in
the Coverage Detection Map

• Area: The total area of a region with detected enhancement

For more information about how Verify calculates the ratings for each use-case application, see Digimarc Verify 
Analysis.

Edge Zones
Edge zones are the four inches along each package edge, following the GS1 Edge rule, as specified in the  GS1 
 General Specifications, section 6.3.3.3: “When possible, the barcode must not be closer than 8 mm (0.3 in.) or 
farther than 100 mm (4 in.) from the nearest edge of the package/container.” These areas are where a fixed 
barcode scanner is most likely to detect a watermark signal when a package moves across its sensor. Rectangular 
and cylindrical packages are handled differently.

• With a rectangular package, each side is measured 4 inches (100 mm) from the edge.
• With a cylindrical package, depending on the orientation of the wrap (whether the artwork is placed

horizontally or vertically on the package), the circumference of the cylinder and the region curvature are
considered.

Digimarc Verify Analysis for Applications
This section describes how the application ratings are calculated for each use case analysis.

• Point of Sale
• Mobile Phone
• Manufacturing
• Robot Monitoring
• Recycling Sortation

Note
The application rating for recycling sortation isn't calculated because the watermarked packages are 
expected to be dirty, crumpled, and moved along a conveyor belt at high speeds.
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Point of Sale

This section discusses how Digimarc Verify analyzes package artwork for the Point-of-Sale application.

Coverage Area
As Verify analyzes the package artwork, it converts the artwork to a grayscale map to determine where 
the artwork has been watermarked. This grayscale map is converted into a binary image, where 
watermarked areas with a fidelity score of over 50 are shown as white, and areas with a score less than 50 
(including all unwatermarked areas) are black.

Front Back

Binary representation of a barcode scanner coverage detection map

To calculate the application rating:

1 For the Point-of-Sale application, Digimarc Verify groups the edge zones by region and calculates the zone 
score for each zone based on its coverage area and fidelity score using a lookup table (see the Coverage 
Area to Zone Score Lookup Table for Barcode Scanning).

2 The zone scores are then aggregated to a region score, which is weighted based on the size of the region 
in relation to the entire package (that is, a larger side is more likely to be scanned by a fixed barcode 
scanner than a smaller side).

3 The region scores are aggregated into a package score, which is the overall likelihood of detection (in 
percent).

4 The package score percentage is then translated into the application rating using a lookup table (see 
the Package Score to Application Rating Lookup Table for Barcode Scanning.
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Sample Application Rating Calculation for Barcode Scanning

Region Edge zone
Zone

area (in2)
Zone
score

Region
score

Region
weight

Package
score

Application
rating

Front

Top 6.9 0.9

0.83 1

0.71 3

Bottom 6.9 0.9

Left 6.9 0.9

Right 2.9 0.6

Back

Top 3.8 0.7

0.6 1
Bottom 3.8 0.7

Left 3.8 0.7

Right 1.2 0.3

Coverage Area to Zone Score 
Lookup Table for Barcode 

Scanning

Covered area (in2) Zone score

≥12.0 ≥1.0

≥6.0 ≥0.9

≥4.2 ≥0.8

≥3.1 ≥0.7

≥2.4 ≥0.6

≥1.8 ≥0.5

≥1.3 ≥0.4

≥0.9 ≥0.3

≥0.6 ≥0.2

≥0.3 ≥0.1

≥0.0 ≥0.0

Package Score to Application 
Rating Lookup Table for Barcode 

Scanning

Package score Application rating

>0.95 5

>0.75 4

>0.50 3

>0.25 2

>0.00 1

=0.00 0

Mobile Consumer Engagement

This section discusses how Digimarc Verify analyzes package artwork for the Mobile Phone application.

Coverage Area
For Mobile Consumer Engagement, Verify uses only one zone, the designated principal display panel of a 
package, to determine the application rating. Mobile devices are assumed to have a 4-inch field-of-view and users 
can point their device anywhere on the package. Verify analyzes the Coverage Detection Map for watermarked 
areas as a percent of the principal display panel. The application rating for the package is determined by the 
region score using a lookup table (see the Region Score to Application Rating Lookup Table for Mobile 
Engagement).

Sample Application Rating Calculation for Mobile Consumer Engagement

Region Covered area (in2)
Zone score
(percent covered)

Region
score

Region
weight

Package
score

Application
rating

Front <0 0.51 0.51 1 0.51 3
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Region Score to Application 
Rating Lookup Table for Mobile 

Engagement

Region score Application rating

>0.95 5

>0.75 4

>0.50 3

>0.25 2

>0.00 1

=0.00 0

Manufacturing

For the Manufacturing application, all defined regions are assessed, with each region used as a single application 
zone. The application rating is based on the availability of suitable target areas and is assessed by the total 
covered area of the entire package. The coverage area is converted to the application rating using a lookup table 
(see the Coverage Area to Application Rating Lookup Table for Manufacturing).

Front Back

Sample Application Rating Calculation for Manufacturing

Region Zone Zone area (in2) Application rating

Front Entire side 9.7

Back Entire side 7.7

Sum of all side coverage 17.4 5
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Coverage Area to Application Rating 
Lookup Table for Manufacturing

Coverage area (in2) Application rating

>4.0 5

>2.0 4

>1.0 3

>0.25 2

>0.00 1

=0.00 0

Robot Monitoring

This section discusses how Digimarc Verify analyzes package artwork for the Robot application.

Coverage Area
For the Robot analysis, Verify uses only one zone, the designated principal display panel of a package, to 
determine the application rating. Verify determines the zone score from the covered area using a lookup table 
(see the Coverage Area to Zone Score Lookup Table for Robot Monitoring). The zone score is translated into the 
application rating using a lookup table (see the Zone Score to Application Rating Lookup Table for Robot 
Monitoring).

Binary Coverage Detection Map for Robot Monitoring

Sample Application Rating Calculation for Robot Monitoring

Region Zone area (in2) Zone score Region score Package score Application rating

Front 6.9 0.5 0.5 0.5 3
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Coverage Area to Zone Score 
Lookup Table for Robot 

Monitoring

Covered area (in2) Zone score

= 18 1.00

= 9 0.75

= 6 0.50

= 3 0.25

= 1 0.10

= 0 0.00

Zone Score to Application 
Rating Lookup Table for Robot 

Monitoring

Zone score Application rating

> 0.95 5

> 0.75 4

> 0.50 3

> 0.25 2

> 0.00 1

= 0.00 0

Recycling Sortation

This section discusses how Digimarc Verify analyzes package artwork for the Recycling application.

Note
Recycling sortation is a supplemental feature. To enable it, navigate to Help > Supplemental Features
and enter the activation code you got from Digimarc.

The application rating for recycling sortation isn't calculated because the watermarked packages are expected to 
be dirty, crumpled, and moved along a conveyor belt at high speeds.

Coverage Area
As Verify analyzes the package artwork, it converts the artwork to a grayscale map to determine where 
the artwork has been watermarked. This grayscale map is converted into a binary image, where watermarked 
areas with a fidelity score of over 50 are shown as white, and areas with a score less than 50 (including all 
unwatermarked areas) are black.

Note
Coverage analysis for Recycling Sortation is available only for artwork that has been watermarked at 
150 WPI.
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Binary representation of a recycling coverage detection map

Front Back

Coverage Area to Zone Score 
Lookup Table for Recycling 

Sortation

Covered area (in2) Zone score

≥12.0 ≥1.0

≥6.0 ≥0.9

≥4.2 ≥0.8

≥3.1 ≥0.7

≥2.4 ≥0.6

≥1.8 ≥0.5

≥1.3 ≥0.4

≥0.9 ≥0.3

≥0.6 ≥0.2

≥0.3 ≥0.1

≥0.0 ≥0.0

Package Score to Application 
Rating Lookup Table for Recycling 

Sortation

Package score Application rating

>0.95 5

>0.75 4

>0.50 3

>0.25 2

>0.00 1

=0.00 0

Version 3.3.1 250421



Guide to Digimarc Verify 41 

Enhancement Report Sections
The Enhancement Report is divided into sections:

• Condensed Summary
• Coverage Detection Map
• Watermark Coverage per Application
• Validation Points Map
• Varnish Map
• Polarity Map
• Fidelity Point Check
• Target-Value Information (TVI)
• General Information
• Consistency Map

Samples of the available enhancement reports follow. Your own enhancement reports will look similar.

Note
The Varnish Map is available only if a varnish channel was identified on the Spot Color Identification
dialog.
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Condensed Summary
Available in all reports, the Condensed Summary displays a summary of the enhancement, including project 
information, application ratings, color separations, and previews of the artwork and the coverage detection map 
for each applicable use case analysis.

Note
Coverage detection maps are applicable only for Point of Sale (Barcode Scanner), Mobile, and 
Recycling analyses. 
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Watermark Coverage per Application
Available in the Full Report and Brief reports, the Watermark Coverage per Application summary shows how 
much of the package is covered by the Digimarc digital watermark, broken down by region for both barcode 
scanners and mobile devices. It includes the number of Digimarc digital watermarks in each region. Coverage 
scores show the overall quality of Digimarc digital watermark coverage, where 100 is best.

Note
This section of the enhancement report applies only for Point of Sale (Barcode Scanner), Mobile, and 
Recycling analyses. Manufacturing and Robot use case analyses don't provide data for this report.
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Coverage Detection Map
Available in the Full Report, the Coverage Detection Map section shows each region for each selected use case 
analysis. The detection maps show the coverage area, percentage, and coverage score for each region in the 
artwork for the relevant use case analyses. For each region, the coverage detection information is presented with 
a preview of the underlying artwork.

Note
This section of the enhancement report is applicable only for Point of Sale (Barcode Scanner), Mobile, 
and Recycling analyses. Manufacturing and Robot use case analyses don't provide useful data for this 
report.

Note
If you create the enhancement report on artwork that has a consistency problem, such as 
mismatched, missing, or extra codes, the Consistency Map section takes the place of this section in the 
Full Report.
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Validation Points Map
This section is available in the Full Report and Inspection reports.

Like for visible barcodes, the data in Digimarc digital watermark must be checked and validated. The Validation 
Points Map notes areas you scan with Digimarc Verify for iOS or Digimarc Verify for Android. Each Digimarc icon 
(   ) represents an ink or separation carrying Digimarc digital watermark and has a corresponding validation 
point to scan. Multiple watermarked separations can be confirmed with the same validation point, indicated by a 
special, multi-color icon (   ). The Validation Points Map shows where the print QC operator uses the phone's 
camera to check the print sample for quality.

Note
Some validation points might be too weak to detect with Digimarc Verify for iOS or Digimarc Verify for 
Android.

To download Digimarc Verify for iOS or Digimarc Verify for Android and find information about this process, visit 
 https://www.digimarc.com/verify.
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Varnish Map
This section is available in the Full Report, Brief, and Inspection reports. The Varnish Map section displays the 
approximate locations of the watermarked varnish elements. Each file can specify up to two varnish channels with 
multiple elements using those channels. The robustness and performance metrics aren't included.

The name of the varnish channel is printed in the title bar of the report section. Each channel is mapped on a 
separate page to differentiate them if the artwork has two varnish channels. In the example below, Varnish 1 and 
Varnish 2 are the channel names.

Note
The Varnish Map is available only if a varnish channel was identified on the Spot Color Identification
dialog.
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Polarity Map
If you see an inconsistent channel polarity warning after running Verify, you can include the Polarity Map 
section in the Full, Brief, and Inspection reports to show areas of the artwork with positive and negative polarity:

• Green areas show positive polarity
• Blue areas show negative polarity

Note
When enabled on the Report Options dialog, the polarity map is produced only if Verify displays the 
inconsistent polarity warning. If no polarity warning is displayed, the polarity map is omitted from the 
report.
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Fidelity Point Check
Available in the Full Report and Inspection report, the Fidelity Point Check shows the key audit locations to 
confirm the printed package has sufficient fidelity to retain the predicted detection measurements from the digital 
files. The Fidelity Points map shows where the print quality control (QC) operator scans the print sample (see 
Validate Your Scanner). The close-up image samples on the second page show where to scan the package to test 
the fidelity.

Note
If you scanned a print sample, the Fidelity Points are indicated by + marks on the coverage map. Fidelity 
Point locations, shown by a letter in the digital file, have a corresponding + mark in the scanned file, 
otherwise, the result is a failure. See Fidelity Point Failure for troubleshooting information.
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Target-Value Information (TVI)
This section is available in the Full Report and Inspection reports.

The Target-Value Information section lists the color values that were used in the evaluation. We provide this 
information to help you troubleshoot fidelity point failures.
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General Information
Available in the Full Report, Brief, and Inspection reports, this section lists general information to keep in mind 
about the generated enhancement reports.
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Consistency Map
If you create the enhancement report on artwork that has a consistency problem, such as mismatched, missing, or 
extra codes, the Consistency Map section takes the place of the Coverage Detection Map in the Full Report. This 
section shows where the Digimarc digital watermark is applied and whether the embedded product code is 
consistent with the traditional barcode:

• Blue areas show matching product codes
• Red areas show a mismatch
• Yellow shows no codes are present
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 Manage Projects

Projects help you manage the watermarked artwork you verify. Each art file must be part of a project. We 
recommend you set the project metadata, such as project and account name, when you create a project.

To create a project:

1 Click + New Project or select Projects > Create Project from the menu. Any open project is closed, and the 
artboard is cleared.

2 Set the project's metadata in the Project panel. 

• Project Name - The name of the project.

• Account Name - The alphanumeric name for the account. This value might vary depending on your
use of Digimarc Verify.

• Project ID - The alphanumeric identifier for the project. This value might vary depending on your
use of Verify.

3 Add artwork. See Add Artwork to a Project.

To open a project:

1 Select Projects > Manage Projects from the menu. The Manage Projects dialog opens.

2 Double-click the desired project. It opens on the artboard. 

Note
Validation results aren't saved in projects when you exit Verify, but they're kept in memory if you 
switch between projects. When you reopen a project, the Results and Maps panels are initially 
empty regardless of past verification activity. Run Verify again to get updated results.

To delete one or more projects:

1 Select Projects > Manage Projects from the menu. The Manage Projects dialog opens.

2 Use the check boxes beside the listed projects to select projects for deletion.

3 Click Delete Checked Projects to delete only the selected projects.

4 Confirm you want to delete the project(s).

To search for a project:

1 Select Projects > Manage Projects from the menu. The Manage Projects dialog opens.

2 Enable the Filter per keyword and type option in the Search section.

3 Choose the field option on which to set the filter.

4 Type the keyword to filter by which the results. Results are narrowed as you type.
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 Manage Region Templates

When you want to apply the same regions to multiple artwork files or print samples, it might be helpful to save the 
regions to a template. Doing so enables you to apply the template to files you want to verify instead of having to 
redraw and name the regions for each file.

Create or Apply a Template
To create a template:

1 Draw the regions for the artwork and name them. See Select Regions for instructions.

2 Select File > Manage Region Templates from the menu. The Manage Region Templates dialog opens.

3 Click Save Current Regions as Template. The Region Template Name dialog opens.

4 Provide a unique Name for the template and click OK. Template names can be up to 24 characters long 
and contain only alphanumeric characters, spaces, parentheses, underscores, and hyphens. 

5 Click Done to close the dialog.

To apply a template to an artwork file or print sample:

1 Open another artwork file or scan another print sample whose layout matches that of the template.

2 Select File > Manage Region Templates from the menu. The Manage Region Templates dialog opens.

3 Select the desired template from the list.

4 Click Apply Template to Current Artwork. You're warned that the operation replaces any existing regions 
you might have defined.

Note
The Apply Template to Current Artwork button is disabled for region templates that are too 
large to fit the artwork.

5 Click Done to close the dialog.
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Export or Import Templates
You can export a saved template to a file in XML format and import a saved template file. This is useful when 
multiple operators are verifying similar artwork files or print samples, each of which contains a different Digimarc 
digital watermark.

To export a template:

1 Select File > Manage Region Templates from the menu. The Manage Region Templates dialog opens.

2 Select the desired template from the list.

3 Click Export Selected Template. The Select Folder dialog opens.

4 Navigate to the folder where you want to save the template and click Select Folder. The template is saved.

5 Click Done to close the dialog.

To import a template:

1 Select File > Manage Region Templates from the menu. The Manage Region Templates dialog opens.

2 Select the desired template from the list.

3 Click Import Template. The Browse for Exported Template dialog opens.

4 Navigate to the template file and click Open.

Note
Template names must be unique. If you have a template with the same name as the one in the 
file, rename or delete the existing template before importing the template file.

5 Click Done to close the dialog.

Rename or Delete Templates
To rename a template:

1 Select File > Manage Region Templates from the menu. The Manage Region Templates dialog opens.

2 Select the desired template from the list.

3 Click Rename Template. The Region Template Name dialog opens.

4 Provide a unique Name for the template and click OK. Template names can be up to 24 characters long 
and contain only alphanumeric characters, spaces, parentheses, underscores, and hyphens.

5 Click Done to close the dialog.
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To delete a template:

1 Select File > Manage Region Templates from the menu. The Manage Region Templates dialog opens.

2 Select the desired template from the list.

3 Click Delete Template. A dialog opens asking if you're sure you want to delete the template.

4 To delete it, click Yes; to cancel, click No.

Note
If you delete the template, it's removed from the list, but the file itself isn't deleted. Use the file 
explorer to find and delete the file, if desired.

5 Click Done to close the dialog.
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 Color Matching in Digimarc Verify

Digimarc Verify can import images in PSD, PDF, AI, BMP, PNG, or TIF formats. The images must be 300 DPI or 
greater and must contain standard process color channels or spot color channels or both. The color channel must 
be 8 bits per channel.

Color Space
The color space of the artwork must be RGB or CMYK, but individual spot colors can be defined (for example, 
through a color picker or color library) in any of the color spaces mentioned here.

Storage
The color information for any channel can be stored in any of the following ways:

• XMP metadata
- Swatch
- Esko

• PSD display information
- RGB
- CMYK
- PANTONE® LAB
- LAB
- Adobe Color Book reference

• TIF channels

Note
CMYK images must contain the four standard process channels and can contain additional spot 
channels. RGB images must contain only the RGB channels; RGBA is not supported.

Matching Sequence
After locating the color definition or description for each color channel in the image file, Verify tries to find a match 
for that color in its internal database. Preview colors for spot color channels are assigned based on the 
matching method used but don't affect the original artwork or analysis. Verify tries to match in the following order, 
so the reflectance values for that color can be used in accurately analyzing the enhancement for the targeted 
environment:

• Exact name match (such as “PANTONE 100 C”); the channel RGB preview color is determined by the
database entry

• Fuzzy name match (such as “PMS 100” or “P 100”); the channel RGB preview color is determined by the
database entry

• Color matching through one of two algorithms, given a comprehensive color definition or description:
- Weighted-XY
- Euclidean distance

• The channel RGB preview color is determined by the existing user-assigned channel preview color

The Digimarc internal database comprises 1951 colors, primarily coated colors. The algorithm can, however, find 
a match for an unknown color that's a close perceptual match for the original color.
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 Troubleshooting

If your enhancement report shows a low score or failure, consult this section for suggested remedies.

Fidelity Point Failure
The Enhancement Report includes a Fidelity Check Point Details page. This page contains details for each Fidelity 
Point, including which ink was modulated (and carries a Digimarc signal) and which ink might also be present in 
the area.

The Channel Color Reference page of the report provides details for each ink present in the image with target 
LAB values, densities, tone values, and reflectance at 670 nm. If your print inspection tool provides 
spectrophotometer data, a direct check of the R670 is the most targeted way to determine the cause of signal 
degradation.

Most common causes of fidelity point failure
You can diagnosed the following issues by inspecting a control strip. Inspect all inks that were enhanced and 
involved.

• An ink is too weak or too strong – perform a density check of that ink in a control strip.

• A color’s hue is incorrect – perform an LAB comparison of that ink in the control strip.

• Color Matching in Digimarc Verify – compare the 100% solid process ink to its mid-tone.

If the ink levels are acceptable, it might be necessary to look at the print under magnification or a loupe to 
diagnose.

• Inspect highlights and shadows for proper dot printing.

• Hybrid screening can compromise signal in highlights.

• LPI below 100 for spot colors can also cause fidelity point failure.

1D Barcode Mismatch
This error occurs when a non-existent 1D barcode is detected in the artwork, or a 1D barcode is present in the 
artwork but isn't detected. Inaccurate region placement can cause this problem. Try adjusting the regions and 
click Run Verify again.

Inconsistent Channel Polarity Is Detected
If a package has multiple enhancement techniques, Verify could interpret the enhancement as the inverse of what 
it expects to detect and give an alert about the channel polarity. This happens within a single channel only, usually 
because of color management, spot colors that have been merged to process colors, or a mix of positive and 
negative binary techniques. If this is the case, try enhancing using a multi-channel technique with the Magenta 
channel only, which ensures the channel polarity isn't inverted. This isn't expected to have a significant impact on 
the Barcode Scanner application. For more information, see Polarity Map.

False Polarity Warning
Two or more hole-enhanced art elements that overlap can cause a false “polarity” warning. These rare false 
alarms can happen when transparency, knockout, and anti-aliasing effects within vector artwork layers interact 
such that anti-aliasing intrudes into uninked holes within a channel and area where ink density has been 
significantly reduced. If your artwork contains overlapping hole-enhanced elements and generates a polarity 
warning, contact Digimarc support for assistance.
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•
•

Failed to open a connection to the device
In some cases, Verify displays an error message when attempting to connect to the   Epson Perfection v39
flatbed scanner. Often, trying again succeeds. If it doesn't:

1 Scan the image and save the resulting file to your computer in one of the supported file formats. See 
Supported Media Formats for more information.

2 Use the Add Artwork from File (   ) option and navigate to the saved image. 

Application exits unexpectedly when importing artwork
When the artwork file name contains Unicode characters, Verify might close unexpectedly. To avoid this:

1 Rename the file using ASCII characters only. 

2 Use the Add Artwork from File (   ) option and navigate to the renamed image. 

Unmarked elements incorrectly identified in reports as watermarked
In rare situations, unmarked CMYK inks printed over spot color elements that were watermarked using the 
Digimarc Watermarking Plug-in for Adobe Illustrator are incorrectly reported as being watermarked. This is a 
problem in the Enhancement Report only and doesn't accurately reflect the presence of watermarks for the 
unmarked inks. This issue can be ignored. Contact Digimarc Support for further assistance or advice.

Background for imported images isn't displayed correctly
When importing PDF version 1.6 artwork that contains transparencies, backgrounds are sometimes missing. As 
a workaround, save the file as PDF version 1.5 or 1.7 and try importing it again.

Digimarc Support
For help using Digimarc Verify, contact support.

 Digimarc Support website
 Send email to Digimarc Support
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Version History

v3.3.1
April  2025

Changes

• Improved modeling of white inks

v3.2
August 2024

Changes

• Verify can now be run on ARM machines without having Rosetta mode enabled
• The term Digimarc Barcode has been removed from the user interface and enhancement reports
• Improved messaging and reporting

New Features

• Added support for watermarks in varnish channels
- As a supplemental feature, this is enabled with a feature code. See Enable Supplemental

Features for instructions
- Enhancement reports now o�er a varnish map

• Added support for verifying watermarks created in the Illuminate preview environment. See Change
Environments for more information

v3.1
May 2024

Changes

• "Secure digital watermark" was revised to "digital watermark"
• Substrate options were moved to the Spot Color Identification dialog

New Features

• Added support for digital watermarks created in the Digimarc Illuminate Platform
- New result categories

• Added white ink support
- New substrate options

• Made several installer updates
• Removed the login requirement for certain features
• Added dark mode support
• Added polarity maps to the Enhancement Report
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v3.3

February 2025

New Features
• Verify now supports retail digital watermarks created in Illuminate.

Wendell Walker
Sticky Note
Accepted set by Wendell Walker
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v3.0
December 2023

New Features

• Project data now persists across sessions with Project Manager
• New region templates
• New configurations are available for reports
• Verify for macOS now supports verifying secure digital watermarks within artwork enhanced with Digimarc

for Packaging Adobe Illustrator Extension v1.8 or later
• Added support for binary V3 verification
• Added software update notification
• Coverage maps for scanned images with mobile use case
• Some new features and existing metric-focused features are now limited to signed-in users. Please log in

to enjoy all Verify offerings!
• Performance improvements

v2.10
April 2021

New Features

• Disabled Recycling analysis
• Added new check boxes in the Spot Color Identification dialog to turn all channels on/off
• Added a new Enhancement Report cover page and reorganized other summary pages
• Added instructional text to the Validation Point, Fidelity Point, and Channel Color Reference pages

v2.9
October 2020

New Features

• Added support for the Recycling application
• Added Fidelity Points to the Barcode Scanner Coverage Map for both CMYK and RGB images
• Added a Color Channel Reference page to the Enhancement Report for CMYK images
• Added the ability to sign into a Digimarc account
• Updated Telemetry preferences to include the option to include the Enhancement Report

v2.8
May 2020

New Features

• Changed “Verification” to “Validation” in the user interface
• Updated validation logic and result messages
• Updated the validation results panel format
• Improved speed and accuracy of traditional barcode detection
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v2.7
February 2020

New Features

• Added improved color management
• Added the ability to select a default ICC Profile

v2.6
October 2019

New Features

• Added Telemetry

v2.5
September 2019

New Features

• Added a new cover page to the Enhancement Report for Application Ratings, which assess a package’s
press-ready, digital artwork file for expected performance in typical usage. The ratings are on a scale from
0 to 5 stars, with 5 being the best. Digimarc Verify assesses four applications: Barcode Scanning, Mobile
Engagement, Robot Monitoring for supply chain and inventory control, and Manufacturing for package
inspection use in manufacturing lines. Ratings for each application can be turned on or off in the
Preferences menu.

• Improved support for cylinders, including partially wrapped label regions, selection of default front and
wrap direction (vertical, horizontal).
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 Glossary

artboard

The main canvas where you draw regions on the packaging artwork. The artboard is on the Regions tab.

artwork

The elements of design and text that makeup packaging, labels, or other visual media, in which a Digimarc digital 
watermark is or will be included.

barcode

The generic term for an optically machine-readable pattern that encodes data in a way that is generally not 
recognizable to human observation.

color channel

Pixels storing intensity information for each component color in an image. Digital images commonly have plural 
color channels - one for each component color. For example, the CMYK color model used in a four-color process 
ink image has four channels: cyan, magenta, yellow, and black.

detect

The process of finding, geometrically aligning, and extracting a payload from a Digimarc digital watermark in an 
image.

Digimarc digital watermark

A novel data carrier that encodes data in media in ways that are generally imperceptible to people, permitting the 
carrier to be repeated many times over the surface of the Enhanced media. It delivers unprecedented ease of use, 
reliability, and efficiency in identifying the media due to massive mathematical and graphical redundancy.

digital watermark

In this guide, digital watermark refers specifically to the Digimarc digital watermark.

edge zone

The four inches along each package edge as specified in the GS1  General Specifications, section 6.3.3.3: “When 
possible, the barcode must not be closer than 8 mm (0.3 in.) or farther than 100 mm (4 in.) from the nearest edge 
of the package/container.”

enhance

The process to integrate a Digimarc digital watermark into a label or package artwork, enabling it for scanning.

enhanced

Label or package artwork that has a Digimarc digital watermark integrated, enabling it for scanning.

enhancement

The result of creating and integrating a Digimarc digital watermark into product packaging and other artwork.

Version 3.3.1 250421



Guide to Digimarc Verify 63

250421

 

enhancement strength

A variable intensity setting at which Digimarc watermarks are applied to an image, showing a degree to which 
artwork color or luminance values are changed by encoding. A higher, or stronger, enhancement strength will be 
more easily detected by machines and might be more visible to consumers.

fidelity block

A configurable image excerpt over which a fidelity score is measured.

fidelity point

The center of a fidelity block, with which a fidelity score for that block is associated.

fidelity score

A quantitative measure of scan performance at a point based on assessing detection of Digimarc digital 
watermark components at that point.

label wrap panel

A white panel with four round handles that's overlaid on cylindrical principal display panel regions. It marks the 
camera-facing portion of a package on a store or warehouse shelf.

point of sale (POS)

The time and place where a retail transaction is completed. Also called Point of Purchase (POP).

preview environment

The Illuminate Platform provides preview and production environments. The preview environment enables you to 
create and test digital twins before taking them to production. Digital twins created in preview can't be used in 
production scenarios and won't resolve, but they're useful for testing.

principal display panel

The side of a package that faces outward on a store or warehouse shelf.

process color

A color comprised of percentages of cyan, magenta, yellow, and black (CMYK) typically printed with halftone 
printing plates.

reflectance

The proportion of light striking a surface that is reflected off it. Contrast can be derived by comparing the 
reflectance of two colors.

regions

Areas you draw on the artboard to tell Verify where to expect digital watermarks.

robustness

The ability of Digimarc digital watermarks to be decoded correctly even if degraded.
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spot color

A color generated by an ink (pure or mixed) that is printed using a single run. This is different from a process color, 
which is produced by overlaying multiple impressions using different colors.

substrate

The base material to be printed on.

supplemental feature

Some features, such as the Recycling Sortation use case analysis, are unlocked with a special code. If you're 
interested in supplemental features, contact Digimarc.

synchronization signal

The reference signal that facilitates detection and geometric registration of a Digimarc digital watermark. Also 
called a "grid."

tile

The fundamental unit of Digimarc digital watermarks, formed by combining an encoded message and 
synchronization signal in a 2-dimensional area, which is repeated in whole or in part across artwork or a label.

validation

The process of checking that the data carried in a Digimarc digital watermark is both accurate and consistent.

validation point

The location in enhanced artwork that is designated for quality evaluation. The data validation process checks the 
GTIN carried in Digimarc digital watermarks, within an inspection area centered at this point, to determine whether 
the GTIN is correct and consistent with the GTIN in other areas and any 1D barcode in the artwork.

verification

The activity of measuring fidelity according to a standard and performing data validation.

waxel

A spatial cell in a tile to which a component of a message and synchronization signal may be mapped. Waxel is 
short for "watermarking element." See "tile."

WPI

The resolution of a Digimarc digital watermark represented as waxels per inch.
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